
https://www.pearson.de/9780137559626


Microsoft Excel Inside Out 

�Office 2�21 and Microsoft ����

Bill Jelen

MrExcel

https://www.pearson.de/9780137559626


Microsoft Excel Inside Out (Office 2021
and Microsoft 365)

Table of Contents

Cover

Title Page

Copyright Page

Contents at a Glance

Table of Contents

Introduction

Who this book is for

Assumptions about you

How this book is organized

About the companion content

Acknowledgments

Support and feedback

Errata, updates, and book support

Stay in touch

Part I: The Excel interface

Chapter 1 What's new in Microsoft 365 Excel

Excel opens faster

Unhide multiple worksheets

Performance improvements

Stock data automatic refresh every five minutes

Show changes from last 60 days

Browse during Save As

https://www.pearson.de/9780137559626


Table of Contents

Searching while opening workbooks

Find dialog box shows all options on open

Smooth scrolling for tall or wide cells

Arrange All in Windows 11

Collapsible tasks panes now support pivot tables

Accessibility tab in ribbon and the navigation pane

New Lambda helper functions

LAMBDA functions now support optional arguments

The ribbon has rounded edges

Cut-out people

Image transparency

Save any object as picture

Write data using the Action Pen

New features introduced tomorrow

Other new features

Chapter 2 Using the Excel interface

Using the ribbon

Using flyout menus and galleries

Rolling through the ribbon tabs

Revealing more commands using dialog box launchers, task panes, and More commands

Using collapsing task panes

Resizing Excel changes the ribbon

Activating the Developer tab

Activating contextual ribbon tabs

Finding lost commands on the ribbon

Shrinking the ribbon

Using the Quick Access Toolbar

Adding icons to the QAT

Removing commands from the QAT

Customizing the QAT

Formatting superscripts and subscripts

https://www.pearson.de/9780137559626


Table of Contents

Using the full-screen File menu

Pressing the Esc key to close Backstage view

Using the new Home screen

Recovering unsaved workbooks

Clearing the Recent Workbooks list

Getting information about the current workbook

Marking a workbook as final to prevent editing

Finding hidden content using the Document Inspector

Avoiding nagging about CSV files

Adding whitespace around icons using Touch mode

Using the new Sheet icon to add worksheets

Navigating through many worksheets using the controls in the lower left

Using the mini toolbar to format selected text

Expanding the formula bar

Zooming in and out on a worksheet

Using the status bar to add numbers

Switching between Normal view, Page Break preview, and Page Layout view

modes 

Unselecting a cell with Ctrl+click

Cleaning data with Flash Fill

Coaching Flash Fill with a second example

Flash Fill will not automatically fill in numbers

Using formatting with dates

Troubleshooting Flash Fill

Sorting data

Sorting by color or icon

Factoring case into a sort

Reordering columns with a left-to-right sort

Sorting into a unique sequence by using custom lists

One-click sorting

Fixing sort problems

Chapter 3 Customizing Excel

https://www.pearson.de/9780137559626


Table of Contents

Performing a simple ribbon modification

Adding a new ribbon tab

Sharing customizations with others

Questions about ribbon customization

Using the Excel Options dialog box

Getting help with a setting

Recent new options in Excel

Using AutoRecover options

Controlling image sizes

Working with protected view for files originating from the Internet

Working with Trusted Document settings

Options to consider

Five Excel oddities

Chapter 4 Keyboard shortcuts

Using keyboard accelerators

Selecting icons on the ribbon

Selecting options from a gallery

Navigating within drop-down menu lists

Backing up one level through a menu

Dealing with keyboard accelerator confusion

Selecting from legacy dialog boxes

Using the shortcut keys

Using my favorite shortcut keys

Quickly move between worksheets .

Jumping to the bottom of data with Ctrl+arrow

Selecting the current region with Ctrl+*

Jumping to the next corner of a selection

Pop open the right-click menu using Shift+F10

Crossing tasks off your list with Ctrl+5

Date stamp or time stamp using Ctrl+; or Ctrl+;

Repeating the last task with F4

Adding dollar signs to a reference with F4

https://www.pearson.de/9780137559626


Table of Contents

Choosing items from a slicer

Finding the one thing that takes you too much time

Using Excel 2003 keyboard accelerators

Invoking an Excel 2003 Alt shortcut

Determining which commands work in legacy mode

Part II: Calculating with Excel

Chapter 5 Understanding formulas

Getting the most from this chapter

Introduction to formulas

Formulas versus values

Entering your first formula

Building a formula

The relative nature of formulas

Overriding relative behavior: absolute cell references

Using mixed references to combine features of relative and absolute references

Using the F4 key to simplify dollar sign entry

Using F4 after a formula is entered 

Using F4 on a rectangular range

Three methods of entering formulas

Enter formulas using the mouse method

Entering formulas using the arrow key method

Entering the same formula in many cells

Copying a formula by using Ctrl+Enter

Copying a formula by dragging the fill handle

Double-click the fill handle to copy a formula

Use the Table tool to copy a formula

Entering one formula and spilling many results

Understanding the #SPILL! error

Using implicit intersection is more complicated than before

Referring to an entire array with the # operator

Chapter 6 Controlling formulas

https://www.pearson.de/9780137559626


Table of Contents

Formula operators

Order of operations

Unary minus example

Addition and multiplication example

Stacking multiple parentheses

Understanding error messages in formulas

Using formulas to join text

Joining text and a number

Copying versus cutting a formula

Automatically formatting formula cells

Specifying implicit intersection using the @ operator

Using date math

Troubleshooting formulas

Seeing all formulas

Highlighting all formula cells

Editing a single formula to show direct precedents

Using formula auditing arrows

Tracing dependents

Using the Watch Window

Evaluate a formula in slow motion

Evaluating part of a formula

Chapter 7 Understanding functions

Working with functions

The Formulas tab in Excel

Finding the function you need

Using Tab to AutoComplete functions

Using the Insert Function dialog box to find functions

Getting help with Excel functions

Using on-grid ToolTips

Using the Function Arguments dialog box

Using Excel Help

Using AutoSum

https://www.pearson.de/9780137559626


Table of Contents

Potential problems with AutoSum

Special tricks with AutoSum

Using AutoAverage or AutoCount

Function reference chapters

Chapter 8 Using everyday functions: math, date and time, and text functions

Examples of math functions

Using SUM to add numbers

Using AGGREGATE to ignore error cells or filtered rows

Rounding numbers

Using SUBTOTAL instead of SUM with multiple levels of totals

Totaling visible cells using SUBTOTAL

Using RAND, RANDARRAY, and RANDBETWEEN to generate random numbers and data

Using =ROMAN to finish movie credits and =ARABIC to convert back to digits.

Using ABS to figure out the magnitude of error

Using GCD and LCM to perform seventh-grade math

Using MOD to find the remainder portion of a division problem

Using SQRT and POWER to calculate square roots and exponents

Using SUMIFS, AVERAGEIFS, COUNTIFS, MAXIFS, and MINIFS to conditionally calculate

Dates and times in Excel

Understanding Excel date and time formats

Examples of date and time functions

Using NOW and TODAY to calculate the current date and time or current date

Using YEAR, MONTH, DAY, HOUR, MINUTE, and SECOND to break a date/time apart

Using DATE to calculate a date from year, month, and day

Using TIME to calculate a time

Using DATEVALUE to convert text dates to real dates

Using TIMEVALUE to convert text times to real times

Using WEEKDAY to group dates by day of the week

Using WEEKNUM or ISOWEEKNUM to group dates into weeks

Calculating elapsed time

Using EOMONTH to calculate the end of the month

Using WORKDAY or NETWORKDAYS or their international equivalents to calculate workdays

Using international versions of WORKDAY or NETWORKDAYS

https://www.pearson.de/9780137559626


Table of Contents

Examples of text functions

Joining text with TEXTJOIN

Using LOWER, UPPER, or PROPER to convert text case

Using TRIM to remove leading and trailing spaces

Using the CHAR or UNICHAR function to generate any character

Using the CODE or UNICODE function to learn the character number for any character

Using LEFT, MID, or RIGHT to split text

Using LEN to find the number of characters in a text cell

Using SEARCH or FIND to locate characters in a particular cell

Using SUBSTITUTE to replace characters

Using REPT to repeat text multiple times

Using EXACT to test case

Using TEXT to format a number as text

Using the T and VALUE functions

Introducing TEXTSPLIT and other text manipulation functions

Chapter 9 Using powerful functions: logical, lookup, and database functions

Examples of logical functions

Using the IF function to make a decision

Using the AND function to check for two or more conditions

Using OR to check whether one or more conditions are met

Using the NOT function to simplify the use of AND and OR

Using the IFERROR or IFNA function to simplify error checking

Examples of information functions

Using the ISFORMULA function with conditional formatting to mark formula cells

Using IS functions to test for types of values

Using the N function to add a comment to a formula

Using the NA function to force charts to not plot missing data

Using the CELL function to return the worksheet name

Examples of lookup and reference functions

Using the CHOOSE function for simple lookups

Moving from VLOOKUP to XLOOKUP

Using FORMULATEXT to document a worksheet

Using numbers with OFFSET to describe a range

https://www.pearson.de/9780137559626


Table of Contents

Using INDIRECT to build and evaluate cell references on the fly

Using the HYPERLINK function to add hyperlinks quickly

Using the TRANSPOSE function to formulaically turn data

Using GETPIVOTDATA to retrieve one cell from a pivot table

Examples of database functions

Using DSUM to conditionally sum records from a database

Using the DGET function

Chapter 10 Using names, LET, LAMBDA, and Tata Types in Excel

Using names in Excel

Using the Name Box for quick navigation

Avoiding problems by using worksheet-level scope

Using named ranges to simplify formulas

Retroactively applying names to formulas

Adding many names at once from existing labels and headings

Using a name to avoid an absolute reference

Storing intermediate formula results using LET

Storing logic in LAMBDA functions

Creating a simple LAMBDA function for the hypotenuse of a right triangle

Sharing LAMBDA functions with other workbooks

Using LAMBDA helper functions

Performing calculations for each row or column

Performing calculations for each item in an array

Performing calculations for each item in an array and returning a single value

Performing calculations for each item in an array and returning each intermediate value

Making an array using MAKEARRAY

Testing for optional arguments using ISOMITTED

Using Data Types in Excel

Dealing with Data Type formulas that return an array

Drilling down through the data card to find an array

Using stock or currency Data Types

Retrieving historical stock prices using STOCKHISTORY

Chapter 11 Connecting worksheets and workbooks

https://www.pearson.de/9780137559626


Table of Contents

Connecting two worksheets

Excel in practice: seeing two worksheets of the same workbook side by side

Creating links between worksheets

Creating links using the Paste Options menu

Creating links using the right-drag menu

Building a link by using the mouse

Links to external workbooks default to absolute references

Building a formula by typing

Creating links to unsaved workbooks

Using the Links tab on the Trust Center

Opening workbooks with links to closed workbooks

Dealing with missing linked workbooks

Updating links when a workbook is renamed or moved

Preventing the Update Links dialog box from appearing

Chapter 12 Dynamic array formulas and names in Excel

Using dynamic array functions to return many results

Sorting with a formula

Filtering with a formula

Using FILTER to select a subset of columns

Extracting unique values with a formula

Generating a sequence of numbers

Generating an array of random numbers with a formula

Refer to the entire array

Learning about new functions and features

Using power formula techniques

Using 3D formulas to spear through many worksheets

Referring to the previous worksheet

Part III: Data analysis with Excel

Chapter 13 Transforming data with Power Query

Using Power Query

Establishing a workflow

https://www.pearson.de/9780137559626


Table of Contents

Loading data using Power Query

Loading data from a single Excel workbook

Transforming data in Power Query

Unpivoting data in Power Query

Adding columns in Power Query

Reviewing the query

Loading and refreshing the data

Splitting each delimiter to a new row

Appending one worksheet from every workbook in a folder

Appending worksheets from one workbook

Creating a custom data type in Excel

Chapter 14 Summarizing data using subtotals or filter

Adding automatic subtotals

Working with the subtotals

Showing a one-page summary with only the subtotals

Sorting the collapsed subtotal view with the largest customers at top

Copying only the subtotal rows

Formatting the subtotal rows

Removing subtotals

Subtotaling multiple fields

Subtotaling daily dates by month

Filtering records

Using a filter

Selecting one or multiple items from the filter drop-down

Identifying which columns have filters applied

Combining filters

Clearing filters

Refreshing filters

Resizing the filter drop-down

Filtering by selection-hard way

Filtering by selection-easy way

Filtering by color or icon

https://www.pearson.de/9780137559626


Table of Contents

Handling date filters

Using special filters for dates, text, and numbers

Totaling filtered results

Formatting and copying filtered results

Using the Advanced Filter command

Excel in practice: using formulas for Advanced Filter criteria

Advanced Filter criteria

Replacing Advanced Filter with a dynamic array formula

Using Remove Duplicates to find unique values

Combining duplicates and adding values

Chapter 15 Using pivot tables to analyze data

Creating your first pivot table

Using artificial intelligence for inspiration with pivot tables

Starting with a blank pivot table

Adding fields to your pivot table using the field list

Changing the pivot table report by using the field list

Dealing with the compact layout

Rearranging a pivot table

Finishing touches: numeric formatting and removing blanks

Three things you must know when using pivot tables

Your pivot table is in manual calculation mode until you click Refreshl

If you click outside the pivot table, all the pivot table tools disappear

You cannot change, move a part of, or insert cells in a pivot table

Calculating and roll-ups with pivot tables

Grouping daily dates to months, quarters, and years

Adding calculations outside the pivot table

Changing the calculation of a field

Showing percentage of total using Show Value As settings

Showing running totals and rank

Using a formula to add a field to a pivot table

Formatting a pivot table

Setting defaults for future pivot tables

https://www.pearson.de/9780137559626


Table of Contents

Finding more information on pivot tables

Chapter 16 Using slicers and filtering a pivot table

Filtering using the row label filter

Clearing a filter

Filtering using the check boxes

Filtering using the Label Filters fly-out

Filtering using the date filters

Filtering to the top 10

Filtering using slicers

Adding slicers

Arranging the slicers

Using the slicers in Excel

Filtering dates

Filtering oddities

Autofiltering a pivot table

Replicating a pivot table for every customer

Sorting a pivot table

Chapter 17 Mashing up data with Power Pivot

Joining multiple tables using the Data Model

Preparing data for use in the Data Model

Creating a relationship between two tables in Excel

Creating a relationship using Diagram view

Building a pivot table from the Data Model

Unlocking hidden features with the Data Model

Counting distinct in a pivot table

Including filtered items in totals

Creating Median in a pivot table using DAX Measures

Time intelligence using DAX

Converting your pivot table to formulas for use on a dashboard

Overcoming limitations of the Data Model

Enjoying other benefits of Power Pivot

Learning more

https://www.pearson.de/9780137559626


Table of Contents

Chapter 18 Using What-If, Scenario Manager, Goal Seek, and Solver

Using What-If 

Creating a two-variable What-If table

Modeling a random scenario using a data table

Using Scenario Manager

Creating a Scenario Summary report

Adding multiple scenarios

Using Goal Seek

Using Solver

Installing Solver

Solving a model using Solver

Chapter 19 Automating repetitive functions using VBA macros

Checking security settings before using macros

Recording a macro

Case study: macro for formatting for a mail merge

How not to record a macro: the default state of the macro recorder

Relative references in macro recording

Starting the macro recorder

Running a macro

Everyday-use macro example: formatting an invoice register

Using the Ctrl+Down-Arrow key to handle a variable number of rows

Making sure you find the last record

Recording the macro in a blank workbook

Editing a macro

Understanding VBA code-an analogy

Comparing object.method to nouns and verbs

Comparing collections to plural nouns

Comparing parameters to adverbs

Accessing VBA help

Comparing adjectives to properties

Using the analogy while examining recorded code

Using simple variables and object variables

https://www.pearson.de/9780137559626


Table of Contents

Using R1C1-style formulas

Entering spillable formulas in macros

Fixing Autosum errors in macros

Customizing the everyday-use macro example: GetOpenFileName and

GetSaveAsFileName

From-scratch macro example: loops, flow control, and referring to ranges

Finding the last row with data

Looping through all rows

Referring to ranges

Combining a loop with FinalRow

Making decisions by using flow control

Putting together the from-scratch example: testing each record in a loop

A special case: deleting some records 

Combination macro example: creating a report for each customer

Using the Advanced Filter for unique records

Using AutoFilter

Selecting Visible Cells Only

Combination macro example: putting it all together

Chapter 20 More tips and tricks for Excel

Watching the results of a distant cell

Calculating a formula in slow motion

Inserting a symbol in a cell

Editing an equation

Protecting a worksheet

Repeat the last command with F4

Bring the active cell back into view with Ctrl+Backspace

Separating text based on a delimiter

Auditing worksheets using Inquire

Inserting and exploring 3D models

Using the inking tools and the Action Pen

Seeing Workbooks Statistics and Smart Lookup

https://www.pearson.de/9780137559626


Table of Contents

Part IV: Excel visuals

Chapter 21 Formatting worksheets

Why format worksheets?

Using traditional formatting

Changing numeric formats by using the Home tab

Changing numeric formats by using built-in formats in the Format Cells dialog box

Using numeric formatting with thousands separators

Displaying currency

Displaying dates and times

Displaying fractions

Displaying ZIP Codes, telephone numbers, and social security numbers

Changing numeric formats using custom formats

Using the four zones of a custom number format

Controlling text and spacing in a custom number format

Controlling decimal places in a custom number format

Using conditions and color in a custom number format

Using dates and times in a custom number format

Displaying scientific notation in custom number formats

Aligning cells

Changing font size

Changing font typeface

Applying bold, italic, and underline

Using borders

Coloring cells

Adjusting column widths and row heights

Using merge and center

Rotating text

Formatting with styles

Understanding themes

Choosing a new theme

Creating a new theme

Reusing another themes effects

https://www.pearson.de/9780137559626


Table of Contents

Saving a custom theme

Using a theme on a new document

Sharing a theme with others

Other formatting techniques

Formatting individual characters

Changing the default font

Wrapping text in a cell

Justifying text in a range

Adding cell notes

Copying formats

Pasting formats

Pasting conditional formats

Using the Format Painter

Copying formats to a new worksheet

Chapter 22 Using data visualizations and conditional formatting

Using data bars to create in-cell bar charts

Creating data bars

Customizing data bars

Showing data bars for a subset of cells

Using color scales to highlight extremes

Using icon sets to segregate data

Setting up an icon set

Moving numbers closer to icons

Mixing icons or hiding icons

Using the top/bottom rules

Using the highlight cells rules

Highlighting cells by using greater than and similar rules

Comparing dates by using conditional formatting

Identifying duplicate or unique values by using conditional formatting

Using conditional formatting for text containing a value

Tweaking rules with advanced formatting

Using a formula for rules

https://www.pearson.de/9780137559626


Table of Contents

Getting to the formula box

Working with the formula box

Finding cells within three days of today

Finding cells containing data from the past 30 days

Highlighting data from specific days of the week

Highlighting an entire row

Highlighting every other row without using a table

Combining rules

Extending the reach of conditional formats

Special considerations for pivot tables

Chapter 23 Graphing data using Excel charts

Choosing from recommended charts

Using the paintbrush icon for styles

Deleting extraneous data using the funnel

Changing chart options using the plus icon

Easy combo charts

Creating a frequency distribution with a histogram chart

Showing financial data with a waterfall chart

Mapping geographic data with a filled map chart

Saving time with charting tricks

Adding new data to a chart by pasting.

Dealing with small pie slices

Saving a favorite chart style as a template

Chapter 24 Using 3D Maps

Examples of 3D Maps

Adding color information for categories

Zooming in

Animating over time

Going ultra-local

Getting your data into a 3D Map

Techniques when using 3D Maps

https://www.pearson.de/9780137559626


Table of Contents

Tipping, rotating, and zooming the map

Adding a photo to a point

Combining layers

Changing column size or color

Resizing the various panes

Adding a satellite photograph

Showing the whole earth

Understanding the time choices

Controlling map labels

Building a tour and creating a video

Using an alternate map

Preparing the store image

Specifying a custom map

Chapter 25 Using sparklines

Fitting a chart into the size of a cell with sparklines

Understanding how Excel maps data to sparklines

Creating a group of sparklines

Built-in choices for customizing sparklines

Controlling axis values for sparklines

Setting up Win/Loss sparklines

Showing detail by enlarging the sparkline and adding labels

Other sparkline options

Chapter 26 Formatting spreadsheets for presentation

Using SmartArt

Elements common in most SmartArt

Inserting SmartArt

Changing existing SmartArt to a new style

Adding images to SmartArt

Special considerations for organizational charts and hierarchical SmartArt

Using shapes to display cell contents

Working with shapes

Using WordArt for interesting titles and headlines

https://www.pearson.de/9780137559626


Table of Contents

Using text boxes to flow long text passages

Using pictures and clip art

Getting your picture into Excel

Inserting a picture from your computer

Inserting multiple pictures at once

Inserting a picture from stock images

Adjusting the picture using the ribbon tab

Resizing the picture to fit

Adjusting the brightness and contrast

Adjusting picture transparency so cell values show through

Adding interesting effects using the picture styles gallery

Applying artistic effects

Removing the background

Inserting screen clippings

Selecting and arranging pictures

Inserting icons, stickers, illustrations, and cut-out people

Examining 3D models

Chapter 27 Printing

Printing in one click

Finding print settings

Previewing the printed report

Using the Print Preview on the print panel

Using full-screen Print Preview

Making the report fit on the page

Setting worksheet paper size

Adjusting worksheet orientation

Adjusting worksheet margins

Repeating the headings on each page

Excluding part of your worksheet from the print range

Forcing more data to fit on a page

Working with page breaks

Manually adding page breaks

https://www.pearson.de/9780137559626


Table of Contents

Manual versus automatic page breaks

Using Page Break Preview to make changes

Removing manual page breaks

Adding headers or footers to the printed report

Adding an automatic header

Adding a custom header

Inserting a picture or a watermark in a header

Using different headers and footers in the same document

Scaling headers and footers

Printing from the File menu

Choosing a printer

Choosing what to print

Changing printer properties

Changing some of the Page Setup settings

Using Page Layout view

Exploring other page setup options

Printing gridlines and headings

Centering a small report on a page

Replacing error values when printing

Printing comments

Controlling the first page number

Chapter 28 Collaborating in Excel

The rise of working remotely in 2020

Storing documents in the cloud

Sharing documents with others

Sharing during the initial save

Sharing using the Share button

Sharing by mentioning in a modern comment

Seeing who has access to the workbook

Knowing when someone shares a workbook with you

Editing the same workbook at the same time

Seeing who else is editing using presence

https://www.pearson.de/9780137559626


Table of Contents

Etiquette for editing at the same time

Avoiding the dreaded veto

Filtering and sorting with Sheet Views

Using threaded comments, mentions, and assigning tasks

Tracking who did what in the workbook

Seeing who changed what with Show Changes

Catching up

Rolling back using Version History

Part V: Appendixes

Appendix A Excel functions

Financial functions in Excel

Logical functions in Excel

Text functions

Text functions for double-byte languages

Date and time functions

Lookup and reference functions

Math and trig functions

Statistical functions

Engineering functions

Cube functions

Information functions

Web functions

Database functions

Add-in functions

Compatibility functions

Alphabetical cross-reference

Appendix B Excel functions with DAX or Power Query equivalents

Excel functions and DAX equivalents

Excel functions with Power Query M equivalents

Appendix C Adding functionality to Excel with add-ins

https://www.pearson.de/9780137559626


Table of Contents

Understanding three types of add-ins and how to activate

Find optimal solutions with Solver

Audit workbooks with Inquire

Get descriptive statistics with the Analysis ToolPak

Find near matches with Fuzzy Lookup

Perform science projects with Data Streamer

Perform Euro conversions with Euro Currency Tools

Generate diagrams from data with Visio Data Visualizer

Perform sentiment analysis using Azure Machine Learning

Generate a chart with people using People Graph

Generate fake data

Test brilliant new functions for Excel with Fast Excel

Index

https://www.pearson.de/9780137559626

